
8-1Software Release 1.0
Part Number 560-968-00, Revision 1

Overview

8
Pa

tte
rn

To
ol

Overview
PatternTool is a graphical tool for reading and editing binary pattern files. By using 
PatternTool, you can directly edit the source pattern file, instead of editing and recompiling 
the ASCII source file. After editing the file with PatternTool, you can update the tester with 
the edited pattern file. PatternTool can help you debug a pattern file by displaying a 
compiled pattern file as columns of data and the History RAM (HRAM) data captured on the 
tester.

Using PatternTool
The pattern file to be debugged is opened with DataTool. In the debug mode, the test 
program is run to the breakpoint, assuming a breakpoint has been set and occurred after at 
least one pattern burst has been run. PatternTool can now be run.

PatternTool is started from DataTool or by clicking the  button on the DataTool 
toolbar. You can locate failures in a pattern file by using PatternTool to examine the pattern 
file and to view the History RAM (HRAM) data generated by the pattern burst. Once a 
problem is found, you can use PatternTool to edit the pattern file.

After editing the pattern file, you can verify the edits to the pattern file by updating the 
pattern file loaded in the tester. The pattern file loaded in the tester is updated without having 
to update the disk file and rerun a pattern burst.

See also:

Worksheets on page 8-2

Toolbars on page 8-3 and Displaying a Pattern File on page 8-8 

Editing with PatternTool on page 8-18

Vectors Worksheet on page 8-29

Other Worksheets on page 8-69

Displaying the History RAM on page 8-81

PatternTool 8
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Requirements
To display or view a pattern file, PatternTool requires a pattern file with a .pat extension. 
PatternTool uses a pattern file to produce a set of worksheets from information in the 
pattern file.

Worksheets
The name of each worksheet appears on the tab at the bottom of the PatternTool window. 
To move between worksheets, click on a tab:

• Vectors Worksheet on page 8-29—contains the vector data from the pattern file, with 
columns for labels, pattern generator microcode, timing set (tset), pin data, and comments. 
Any data on this sheet can be edited. You can also overlay the HRAM data on the Vectors 
worksheet.

• Pin List Worksheet on page 8-70—is the pin list from the pattern file, with columns for each 
pin or pin group, its radix, and the number of pins in the group. Pins can be moved in and 
out of the pin groups on this sheet.

• Pin Setups Worksheet on page 8-72—is the pin_setup statement from the pattern file, 
defining any special modes for pins: mux mode pins, SCIO pins, high-voltage pins, or 
frequency counter pins. Certain pin setups can be edited.

• Options Worksheet on page 8-76—lists the compilation options selected for the pattern file. 
Some options can be edited.

• Imports Worksheet on page 8-79—contains the tset (time set) names and label names 
imported into the pattern file by the import statement. This sheet can be edited.

• Instruments Worksheet on page 8-80—contains information from any instruments 
statement in the pattern file.

Menu commands and shortcuts for displaying the next or previous worksheet:

Find/Goto | Goto | Next Worksheet Control+Page Down

Find/Goto | Goto | Previous Worksheet Control+Page Up
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PatternTool provides the following toolbars:

• Standard Toolbar on page 8-4

• Edit Toolbar on page 8-6

• Debug Toolbar on page 8-7

• Current Cell Bar on page 8-7

• Status Bar on page 8-7

Displaying or Hiding Toolbars
Toolbars are displayed when you place a checkmark next to the toolbar name in the Toolbar 
menu. Highlighting a toolbar name in the Toolbar menu displays a toolbar; unhighlighting a 
toolbar name hides the toolbar. The following commands display or hide a specific toolbar:

View | Toolbar | Standard

View | Toolbar | Edit

View | Toolbar | Debug

View | Toolbar | Current Cell
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Standard Toolbar
The Standard toolbar, shown below, contains icons for the standard Windows file and 
editing commands:

• New  —creates an empty pattern file and displays it in a new window. Shortcut: Control 

+ N. To open an existing pattern file, use Open.

• Open  —opens and loads an existing pattern file (.pat) in a new window. Shortcuts: 
Control + O or Control + F12. Selecting this command opens a window for you to select a 
file; be sure to open only pattern files. To open a pin map, refer to Using Read Pinmap on 
page 8-76.

• Save  —saves the active pattern file to its current name and directory. If you created a 
pattern file, but have not yet saved it, the Save As dialog box appears for you to enter a name 
and folder for the pattern file. Before saving the pattern file, PatternTool checks the file; 
refer to File Checking on page 8-14.

• Cut  —removes the data from the currently-selected cells and puts it on the clipboard. 
Shortcuts: Control + X or Shift + Delete. This command is disabled if no data is in the 
selected cell. Cutting data to the clipboard replaces the contents of the clipboard; refer to 
Editing Cell Data on page 8-23 and Cutting, Copying, and Pasting Vector Data on page 8-
56.

• Copy  —copies the data from the currently-selected cells on the clipboard. Shortcuts: 
Control + C or Shift + Insert. This command is disabled if no data is in the selected cell. 
Copying data to the clipboard replaces the contents of the clipboard; refer to Editing Cell 
Data on page 8-23 and Cutting, Copying, and Pasting Vector Data on page 8-56.

• Paste  —inserts a copy of the clipboard contents into the currently-selected cell or cells. 
Shortcuts: Control + V or Shift + Insert. This command is disabled if the clipboard is 
empty; refer to Editing Cell Data on page 8-23 and Cutting, Copying, and Pasting Vector 
Data on page 8-56.

• Print  —prints the currently-displayed tab of the active pattern file. If the Message 
window is the active window, it is printed. Shortcuts: Control + P or Control + Shift + F12. 
Selecting this command opens a standard Print dialog box, providing the standard printing 
features, such as Print Preview and Print Setup.
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• About  —displays the PatternTool version number and copyright notice.

• Help  —displays the standard online help for a selected item. When you click this 
button, the mouse pointer is transformed into the standard Windows Help icon: an arrow 
and a question mark, which provides the standard context-sensitive help features. Shortcut: 
Control + F1.
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Edit Toolbar
The Edit toolbar, shown below, contains icons for the standard Windows editing commands 
and several FLASH 750 commands for editing pattern files:

• Paste Text command  —pastes the copied ASCII text from PatternTool or another 

application; refer to Paste Text on page 8-57.

• Paste Pin Data command  —pastes the data copied in the pin data format; refer to Paste 
Pin Data on page 8-57.

• Fill Down command  —copies the cell contents to the selected cells below; refer to 

Editing Cells with the Fill Commands on page 8-24.

• Fill Right command  —copies the cell contents to the selected cells to the right; refer 

to Editing Cells with the Fill Commands on page 8-24.

• Fill From Current Cell command  —copies the cell contents to all selected cells; refer 

to Editing Cells with the Fill Commands on page 8-24.

• Complement command  —changes each pin state to its complement (0 to 1, L to H); 

refer to Complementing on page 8-53.

• Swap 0/1 with L/H command  —swaps the drive and receive data (0 to L, H to 1); refer 

to Swapping the Drive and Receive Data on page 8-54.

• Find Previous command  —finds the previous instance of the search string; refer to 

Find on page 8-27. Shortcut: Shift + F3.

• Find Next command  —finds the next instance of the search string; refer to Find on 

page 8-27. Shortcut: F3.
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Debug Toolbar
The Debug toolbar, shown below, contains icons for frequently-used commands that manage 
the display of the site contents of the History RAM (HRAM):

• Refresh command  —refreshes the HRAM display; refer to Viewing Sites on page 8-

89.

• Select Site command  —selects a different site to view; refer to Viewing Sites on page 

8-89.

• Next Site command  —selects the next site to view; Viewing Sites on page 8-89.

• Previous Site command  —selects the previous site to view; refer to Viewing Sites on 

page 8-89.

Current Cell Bar
This toolbar displays the contents of the currently-selected cell; refer to Selecting the Current 
Cell on page 8-20. Use this toolbar when the displayed text for all cells extends beyond one 
screen. The Current Cell bar is read-only; thus, to change the cell contents, you must edit the 
cell; refer to Editing Cell Data on page 8-23.

To display or hide the Current Cell bar, use the following command:

View | Toolbar | Current Cell

Status Bar
The status bar at the bottom of the window shows connection information about the test 
program, which is useful for debugging; refer to Connecting to a Job for Debugging on page 
8-82.

To display or hide the status bar, use the following command:

View | Status Bar
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Displaying a Pattern File
PatternTool opens separate windows when you open an existing pattern file or create a 
pattern files. Windows can be split, and more than one window can be open:

• Opening an Existing Pattern File on page 8-8

• Opening a New Window on page 8-8

• Splitting the Pattern File Window on page 8-8

• Opening Multiple Windows on page 8-9

Opening an Existing Pattern File

Use the Open command to open and load an existing pattern file (.pat) in a new window. In 
the Open dialog that appears, select only pattern files. To open a pinmap, refer to Using Read 
Pinmap on page 8-76.

Opening a New Window

You can open a new window with the same contents as the active window by selecting New 
Window on the View menu. This feature lets you display different parts or views of a pattern 
file at the same time.

The new window uses the current Pin List tab to display the file contents. If columns in the 
original window has been expanded or regrouped, or if the display radix has been changed, 
these changes are ignored in the new window. If the Pin List tab has been edited, these 
changes are displayed in the new window.

If multiple copies of the same document are open at one time, changes to the contents of one 
window are immediately displayed in the other windows. Changes to the appearance of the 
window are ignored.

Splitting the Pattern File Window

Window can be split to simultaneously view two or four different parts of a single worksheet. 
To split a window, select Splitter View on the View menu. Another window is created based 
on the current worksheet in the active window. 
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To split this new window:

1. Find the split box:

a. If the grid extends vertically beyond the window, a split box is at the top of the vertical 
scroll bar: it is a small rectangle above the up arrow, as shown below.

b. If the grid extends horizontally beyond the window, a split box is left of the horizontal 
scroll bar, to the left of the left-arrow.

2. Place the mouse pointer on the split box. The pointer becomes a two-headed arrow. 

3. Click the pointer in the split box and drag the split bar to the position to split. 

4. If both the vertical and horizontal split boxes appear, you can use two split bars to create 
four panes.

5. When finished with the split view, close the window by selecting Close under the File menu 
of the pattern file window or click on the close window (X) icon in the PatternTool 
window. Any changes to the splitter view window will appear in the regular window.

Opening Multiple Windows

The Window menu provides the standard commands for managing the display of multiple 
pattern files in the main window:

• Tile—arranges the multiple windows so all are equally visible and not overlapped.

• Cascade—overlaps the multiple windows so the top window is completely visible; only the 
title bars of the other windows are visible.

• Arrange Icons—arrangesthe icons of the minimized windows along the bottom of the main 
window. If a document is open at the bottom of the main window, some or all of the icons 
may not be visible because they are under this document window.

The numbers at the bottom of the Window menu represent the currently-open documents, 
including the Message window. Click one of these numbers to activate a window. A 
checkmark next to the window number indicates the active window.

Split box
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Changing the Column Appearance
Overview

The appearance of the selected columns of data can be changed:

• Hiding and Exposing Columns on page 8-11

• Resizing Columns and Rows on page 8-12

• Moving Columns in a Vector Display on page 8-30

To change the appearance of columns in a Vectors worksheet, refer to Changing the Column 
Appearance on page 8-10.

+ Even though the appearance of the columns in a worksheet are 
changed, the contents of the data in the columns is not changed.

Selecting a Column

To change the appearance of a cell, select one cell by clicking on it. Once you have selected a 
cell, the entire column is selected. Selecting an entire column is not necessary. If you select 
an entire row by left-clicking in the row header in the leftmost column, all columns are 
selected; thus, any future commands or operations will affect all columns.
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Hiding and Exposing Columns
Overview

Hiding a column removes it from the display without deleting it. You can hide any column on 
any worksheet except for the far left columns containing the row headers. You can hide or 
expose columns by using the menu bar or by using the mouse.

Using the Menu Bar

• To hide a column, select the column by using the mouse to select at least one cell in the 
column. Then, select Hide on the Column menu.

• To expose a hidden column, select Expose on the Column menu. A window appears listing 
the hidden columns. On the Vectors worksheet, a dollar sign prefix indicates a standard 
column name: for example, $label or $tset. Names without a dollar sign are pins or pin 
groups. Click on the column or columns to expose them and then click OK.

Using the Mouse

• To hide a column, you can resize it to zero width by grabbing the right edge of the column 
header (gray rectangle at top of column) and by moving it until it meets the left column.

• To expose a hidden column, double-click on the line separating the headers of the two 
columns between the hidden column.

Hiding and Exposing Memory (MTM) Columns

Displaying the MTM (Memory) data adds several columns to the Vectors worksheet; refer to 
the Memory (MTM) Data on page 8-63. The Hide MTO and Expose MTO commands in the 
Column menu hide or expose all columns of memory data.

Cutting, Copying, and Pasting Hidden Columns

If entire rows are cut, copied, or pasted, the data in any hidden columns in the row is also cut, 
copied, or pasted. However, if only a range of pin data cells on the Vectors worksheet is 
selected (not an entire row), no data is cut or copied from any hidden cell, and no data is 
pasted to any hidden cell.
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Resizing Columns and Rows
Resizing Columns to a Specific Width

1. Select at least one cell in the column. To select all columns, click on the row header, which 
selects an entire row, as well as all columns.

2. Select Resize on the Column menu. A dialog box appears.

3. In the dialog box, enter the desired pixel width of the column. Default is 80. If you use the 
default value, many columns are truncated, but most are visible. You can resize individual 
columns.

AutomatIcally Resizing Columns

An auto resize feature provides several ways to resize the entire column to the desired width:

• Resize an entire column to the width of the widest text in one of the columns:

1. Select the entire column by clicking in the column header.

2. Select Auto Resize on the Column menu.

• Resize an entire column to the width of a specific cell:

1. Select the desired cell as the standard for all cells in the column.

2. Select Auto Resize on the Column menu.

• Resize all columns, including headers, to the maximum cell width:

1. Select the entire grid by clicking on the gray blank rectangle at the upper-left corner of the 
grid; refer to Selecting the Entire Grid on page 8-22.

2. Select Auto Resize on the Column menu.

Manually Resizing Columns

To manually resize a column by using the gray column headers at the top of the worksheet 
data area:

1. Position the cursor on the right border of the column header, until the cursor becomes a two-
headed arrow.

2. Hold the left mouse button down to grab the border.

3. Pull the border to widen or narrow the column.
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Resizing the Row Height

To change the height of all rows in the Vectors worksheet:

1. In the far left column of the gray row headers, which contain the vector numbers, put the 
cursor on the bottom border of a row header cell.

2. Position of the cursor until it becomes two-headed arrow.

3. Hold down the mouse button to grab the border.

4. Pull the border down to increase the cell height. All rows of the grid are resized to the same 
height.

If any column headers are too long to fit in the current column width, you can resize the row 
of column headers without changing the rest of the data rows of the grid. By increasing the 
height of the column header row, the headers are expanded vertically.
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File Checking
Overview

When you compile an ASCII source file, the Pattern Compiler verifies the pattern syntax; 
however, when you use PatternTool, you are editing a compiled file, and the compiler 
cannot verify the pattern syntax in the edited file. Consequently, when you try to save a 
pattern file after editing it, PatternTool verifies the pattern syntax. Because a file is checked 
only when it is saved, the syntax of the pattern file may be temporarily invalid while you are 
editing it. For example, if you change the opcode_mode option from extended to normal, 
other parts of the pattern file may change, such as, the normal mode not allowing pin setups 
that are valid in the extended mode.

Items Checked in Pattern File

• tset numbers and tset names cannot both be used.

• Duplicate tsets and duplicate labels cannot be used.

• All tset names must be imported. Any external labels referenced in the file must also be 
imported. All symbols on the Imports worksheet must be valid.

• If the opcode_mode option is normal, the following pin setup modes cannot be used: mux, 
io_midband, io_valid, freq_count. These are valid only in the extended mode.

• The extended and normal modes have different value ranges for min_period.

• Pattern file cannot contain both pins (pin names and pin group names) and channel 
numbers.

• Channel numbers only: the proper channel number must be used for any high_voltage pin 
setup mode.

• Vector cannot contain both the halt opcode and the ign control bit.
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File Fails File Checking

If you try to save a pattern file or update the tester with a pattern file and the file fails the file 
check, how PatternTool behaves depends on the command you issued:

• Save command—the failed file is not saved. PatternTool does not overwrite the existing 
valid file.

• Save As command—PatternTool writes the failed file to the specified filename, but the 
file is marked as invalid. PatternTool cannot subsequently open an invalid file.

• Update Tester command—Before PatternTool updates the tester with the active pattern 
file, it checks the file; refer to Updating the Tester with the Edited Binary Pattern File on 
page 8-17.

If the file check fails, the error messages are written to the Message window; refer to 
Message Window on page 8-16.
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Message Window
Overview

PatternTool displays error, warning, and general messages in the Message window:

• If a pattern file fails file checking, error and general messages are written to the Message 
window.

• If an edited Pin List worksheet or Pin Setups worksheet fails to update the worksheet, all 
resulting messages are written to the Message window.

PatternTool uses one window for writing messages for all pattern files opened from a single 
instance of PatternTool. This window displays the message number, message type (E=error, 
W=warning, I=informational), location, and message. The location consists of the filename, 
the tab name, and the row number.

Viewing the Message Window

If PatternTool has detected errors, a popup reports the number of errors. After you click OK 
in the popup to acknowledge the message, the Message window appears.

Once PatternTool has initially created a Message window, you can view it at any time by 
selecting the Message Window on the View menu or the Messages file on the Window menu.

Clearing the Message Window

PatternTool does not clear messages from the Message window until you exit 
PatternTool. New messages are appended; thus, the window may contain messages from 
several failed attempts to save a file. To clear all current messages, select Clear All on the 
Edit menu. This command is enabled only when the Message window is the active window.

Exiting the Message Window

To exit the Message window, go to the Window menu and select any other file already 
opened.
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Updating the Tester with the Edited Binary Pattern File
Overview

After editing a binary pattern file with PatternTool, you can update the pattern file loaded 
on the tester to verify the edits to the pattern file. This method does not save the file to disk, 
which would overwrite the existing pattern file. 

To update the tester with the edited pattern file, click Update Tester command in the Debug 
menu. The active pattern file is written to a temporary file and then the pattern syntax is 
checked. If the pattern syntax is valid, the tester loads this temporary file.

Requirements

• PatternTool is connected to the tester; Connecting to a Job for Debugging on page 8-82.

• Pattern file to update is already loaded.

• Active window displays the pattern file to update the tester. 

• Viewing mode is File Data, not HRAM. 

• Edited pattern is the only pattern in a pattern burst. 

• Multiple files in a burst are not supported. 
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Editing with PatternTool

Overview
The following editing features apply to all PatternTool worksheets:

• Selecting Data to Edit on page 8-19

• Changing the Column Appearance on page 8-10: hiding, exposing, resizing, and moving

• Editing Cell Data on page 8-23: editing cells directly, using dialog boxes, or using the Fill 
or Cut, Copy, and Paste commands.

• Using Find, Replace, and Goto on page 8-27

• Inserting and Deleting Rows on page 8-26 

In addition to the these general editing features, several worksheets have additional editing 
features:

• Vectors Worksheet on page 8-29

• Other Worksheets on page 8-69
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Selecting Data to Edit
Overview

Before you can edit or manipulate the data in a pattern file, you must select the data in the 
cell or the cells.

See also:

Selecting the Current Cell on page 8-20

Selecting a Range of Cells on page 8-20

 Editing Cells Directly on page 8-23

Editing Cells with Drop-Down Lists on page 8-23

Editing Cells with Edit Popups on page 8-24

Editing Cells with the Fill Commands on page 8-24

Editing with the Cut, Copy, and Paste Commands on page 8-25

Invalid Cell Data on page 8-25

Inserting and Deleting Rows on page 8-26

Using Find, Replace, and Goto on page 8-27
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Selecting the Current Cell

Pattern data is displayed in a grid of cells with only one of those cells as the currently-
selected cell, also known as the current cell. As shown below, the current cell has an outline 
around it. Also, as shown below, the current cell may contain a button to open an editing 
dialog box or a drop-down list:

To select a cell as the current cell, click on it once. Once a cell is selected, you can change the 
selected cell by using the drop-down list or by directly entering data.

Selecting a Range of Cells

A selected range of cells is highlighted by reverse video: white text on a black background. 
The first cell clicked on is the current cell, which is not in reverse video (except for a split 
view: the entire range is in reverse video). Having selected a range, use the arrow keys to 
select a different current cell that is not part of the selected range without de-selecting the 
current range of cells.

Selecting a Rectangle of Adjacent Cells

Two methods for selecting a rectangle of adjacent cells:

• Left-click on the cell in one corner of the desired rectangle. While holding down the left 
mouse button, drag the cursor to the opposite corner to select the rectangle of cells.

• Left-click on the cell in one corner of the rectangle. Hold down the Shift key and left-click 
on the cell in the opposite corner to select the rectangle of cells.
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Selecting Non-Adjacent Cells

1. Select the first cell or range of cells. 

2. Hold down the Control key and select the next cell or range of cells.

Selecting an Entire Column

Left-click on the column heading, which is the gray rectangle with a label at the top of the 
column.

Also, refer to Changing the Column Appearance on page 8-10.

Selecting More than One Column

• For adjacent columns:

1. Left-click on the first column heading in the range of cells.

2. Hold down the mouse button and drag the cursor to the last column heading.

OR

1. Left-click on the first column heading.

2. Hold down the Shift key and left-click on the last column heading.

• For non-adjacent columns:

1. Select the first column heading or headings.

2. Hold down the Control key and select the next column heading or headings.

Selecting an Entire Row

Left-click on the row heading, which is the gray rectangle in the leftmost column, containing 
a number or identifier.

When inserting or deleting rows or vectors, you select the entire row by selecting just one cell 
in a row; refer to Inserting and Deleting Rows on page 8-26.
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Selecting More than One Row

• For adjacent rows:

1. Left-click on the first row in the range.

2. Hold down the mouse button and drag the cursor through to the last row.

OR

1. Left-click on the first row heading.

2. Hold down the Shift key and left-click on the last row heading.

• For non-adjacent columns:

1. Select the first row heading or headings.

2. Hold down the Control key and select the next row heading or headings.

Selecting the Entire Grid

Left-click in the gray blank rectangle at the upper-left corner of the grid, which is the 
intersection of the column headings and the row headings; see the following figure.

Clearing All Selections, Including the Current Cell

1. Select the entire grid by left-clicking in the gray, blank rectangle in the upper-left corner of 
the grid.

2. Left-click again in the same rectangle. All selections are cleared.

Select entire grid by clicking here.
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Editing Cell Data
Editing Cells Directly

You can edit the current cell by selecting Edit Cell on the Edit menu or by pressing the F2 
key. An editing cursor appears. You can now delete and add characters in the existing text.

You can also edit a selected cell by typing in the cell:

• If you click on the white space in a cell or navigate to the white space in a cell with the 
arrow keys, the cell is selected but the edit cursor does not appear. Even though the edit 
cursor does not appear, what you type replaces the contents of the cell.

• If you click on the text in a cell, an edit cursor appears in the text. You can delete and add 
characters in the existing text. Once an edit cursor is visible, the left and right arrows keys 
move the cursor within the cell text.

If you enter invalid data, you cannot exit the cell until you change the invalid characters by 
entering valid data or discard the changes and exit the cell by pressing the Esc key. After you 
exit the cell, the cell text returns to its original value.

To move from the current cell to adjacent cells, use the arrow, Tab, or Return keys.

Editing Cells with Drop-Down Lists

Some cells have a drop-down list. After you select a cell, a gray button with an inverted 
triangle appears, shown below, signifying a drop-down list:

Clicking the button displays a drop-down list with valid values to select. The button is visible 
only for the current cell. 

These cells can also be directly edited.
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Editing Cells with Edit Popups

Some cells provide an edit popup dialog box for entering a valid cell value. You enter 
selections in the dialog box until the desired cell value is displayed in the Vector worksheet. 
You can also directly edit these cells.

After you select a cell, a gray button with a curved arrow appears, shown below, signifying 
an edit popup. The button is visible only for the current cell:

You can open the dialog box for the selected current cell by using one of several methods:

1. Click the gray button or a non-text part of the cell.

2. Select Cell Edit Popup on the Edit menu.

3. Press the F7 key.

Editing Cells with the Fill Commands

Another way to edit cells is to use the Fill commands in the Edit menu to copy the contents of 
the current cell to other cells. The Fill commands also have the following buttons on the Edit 
Toolbar:

• Fill From Current Cell command  —copies the current cell to all selected cells. The 

text must be valid for all affected cells; otherwise, the text is not copied. Multiple cells can 
be selected to receive the copied text.

• Fill Right command  —requires that you select a single rectangle of at least two 

columns. In each row, the value in the far left cell of the selected region is copied to all other 
cells in the same row within the selected region.

• Fill Down command  —requires that you select a single rectangle of at least two rows. 

In each column, the value in the top cell of the selected region is copied to all other cells in 
the same column within the selected region.

Fill commands do not copy hidden cells.
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Editing with the Cut, Copy, and Paste Commands

You can use the Cut, Copy, and Paste commands in the Edit menu to edit a worksheet. To use 
these editing commands, click the appropriate icons in the Standard toolbar or press the 
appropriate shortcut keys:

• Cut  —Ctrl+X

• Copy  —Ctrl+C 

• Paste  —Ctrl+V

Compared with than in other worksheets, cutting, copying, or pasting data in a Vectors 
worksheet may have different effects. Also, only the Vectors worksheet supports several paste 
operations; refer to Cutting, Copying, and Pasting Vector Data on page 8-56.

Invalid Cell Data

Invalid cell data may be displayed because the worksheet has been changed during editing. In 
this case, the cell background appears pink, indicating the cell has invalid characters. 
Correcting the value causes the pink background to disappear. For example, if you edit the 
Options tab by changing from the Extended mode to the Normal mode, some opcodes or pin 
data values on the Vectors tab may become invalid. Invalid cells are highlighted in pink.
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Inserting and Deleting Rows

Overview

You can insert and delete rows on the editable worksheets without a fixed number of rows; 
however, you cannot delete rows on the Options tab because each option must have one row.

On the Vectors worksheet, vectors are inserted and deleted, not rows; refer to Inserting 
Vectors in a Pattern FIle on page 8-59 and Deleting Vectors from a Pattern File on page 8-
59. 

Inserting Rows into Worksheet

1. From the Insert Mode command on the Edit menu, select where to insert the new rows:

Insert Before Selection
Insert After Selection
Insert Before Current Cell

2. Highlight the same number of rows as the number of rows to insert. For example, to insert 
5 rows, select 5 rows as the current rows. Select a row by highlighting at least one cell in 
the row.

3. After selecting the correct number of rows, select Insert Rows on the Edit menu. The new 
rows will be blank.

Deleting Rows from Worksheet

1. Select the rows to delete by clicking on them in the far left heading column. You must select 
the entire row to delete it.

2. Select Remove Rows on the Edit menu. If you select multiple non-adjacent cells by holding 
down the Control key while clicking on the cells, the Remove Rows command is disabled. 
This command removes only a single row at a time.
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Using Find, Replace, and Goto

Overview

You can find a string of text or navigate to particular points in a worksheet sheet by using the 
Find Text or Goto commands. A particular string of text can be searched for and replaced by 
using the Find/Replace Text command.

Find

To find text, select Find Text in the Find/Goto menu or use the shortcut keys Control + F. The 
Find dialog box appears:

1. In the Find what box, enter the string to be found.

2. Click Match case, if desired.

3. Select the direction of the search: Up or Down.

If Up or Down is selected, PatternTool searches within the selected range; otherwise, it 
searches the entire worksheet, wrapping when it reaches one end of the worksheet.

4. After entering text in the Find dialog box, you can search for the next or previous match by 
using Find Next and Find Previous in the Find/Goto menu, the appropriate icons in the Edit 
toolbar or the shortcut keys:

• Find Next  —F3

• Find Previous  —Shift + F3

+ Text in hidden columns is not searched; refer to Hiding and Exposing 
Columns on page 8-11.

Find Fail

Find Fail command is enabled only when displaying the History RAM (HRAM); refer to 
Finding Fails on page 8-89.
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Find/Replace Text

To search for and replace text, click Find/Replace Text on the Find/Goto menu. The Replace 
dialog box appears:

1. In the Find what box, enter the string to be found.

2. In the Replace with box, enter the text to replace the found text.

3. Click on Match case, if desired.

4. Click Find Next. If a match is found, the matched text is highlighted.

5. To replace only this single match of text with the replacement text, click Replace.

6. To replace all matches of the text with the replacement text, click Replace All.
7.  To find the next match, click Find Next.

After entering text in the Find dialog box, you can search for the next or previous match by 
(1) clicking Find Next or Find Previous in the Find/Goto menu, (2) the appropriate icons 
in the Edit toolbar, or (3) the shortcut keys.

Goto

To go to a specific location on a worksheet, click Goto in the Find/Goto menu and then use 
the submenu to select the location:

• Top or Bottom column

• Leftmost or Rightmost row

• one Page Up or one Page Down

• next Vector (F5)

• Next Worksheet or Previous Worksheet (Control + page down or Control + page up)

If you have scrolled away from the current-selected cell, return to that cell by clicking Goto 
Current Cell in the Goto menu.

Additional Search Features on the Vectors Worksheet

The Vectors worksheet provides additional search and navigation commands: Goto Vector 
and Goto Label; refer to Using Find/Goto on the Vectors Worksheet on page 8-46.



PatternTool 8

8-29Software Release 1.0
Part Number 560-968-00, Revision 1

Vectors Worksheet

8
Pa

tte
rn

To
olVectors Worksheet

Overview
The Vectors worksheet, which displays the vector data in a pattern file, is based on the 
vector statement in the pattern file; refer to Vector Statement on page 6-30, Pattern 
Language Reference, Chapter 6. 

Columns

For information on individual columns of the Vectors worksheet, including editing specific 
columns and editing popup dialog boxes, refer to the following items:

• Vector Number Column on page 8-31

• // column on page 8-31

• label Column on page 8-32

• patgen Column on page 8-33

• tset Column on page 8-34

• Pin Data Columns on page 8-35

• comment Column on page 8-36

Columns on this worksheet can be moved, hidden, or exposed.

Special Vector Data

This worksheet displays the standard data from the pattern file, as well as the MTM (Memory 
Test Module) data, which may require additional columns or special modes of display; refer 
to Memory Data Columns on page 8-63.

Editing the Vectors Worksheet

All editing features mentioned in Editing with PatternTool on page 8-18 also apply to this 
worksheet. Other editing features, such as changing the radix of the pin data columns or 
adding comments are supported only by the Vectors worksheet; refer to Editing the Vectors 
Worksheet on page 8-45.
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Moving Columns in a Vector Display

1. Select the entire column by clicking the left mouse button once on the column header. 

2. Release the left mouse button and click on the column header again. A small, gray rectangle 
appears, indicating the column can be moved.

3. Hold down the mouse button and move the cursor in the desired direction. A red dotted 
vertical line appears, shown below, indicating the current position of the moved column. 
This line indicates where the left border of the moved column would be:

4. When the column is in the proper position, release the mouse button.

Restriction

The // (block comment) column on the Vectors worksheet should not be moved from its 
position, which is next to the vector number column. If this column is moved, block 
comments cannot be displayed or entered; refer to Block Comments on page 8-61.

Current position of moved column

Column for block comments
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Vectors Worksheet Columns
Vector Number Column

Overview

The far left column lists the vector number. Vectors are numbered sequentially, starting from 
0. You cannot edit this column.

Block comments have special numbering, in the form 5.C:1, signifying this comment (C) 
appears after vector 5, on the second line of the block comment; 0 is the first line.

Vector Number Rules

• If any pins are in the SCIO or mux mode, each vector requires two rows, with numbering 
in the format 5.1 and 5.2.

• Vector numbers are assigned by PatternTool.

// column

If a column displays //, adding block comments is enabled. Block comments extend the 
width of the window; however, block comments are not added in this window.

Existing block comments can be edited, and new block comments can be inserted; refer to 
Block Comments on page 8-61.

Column for block comments
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label Column

Overview

If the current cell supports labels, this column displays a vector label and a button.

Editing the label Column

Edit a label by the following methods:

• Click the button to open the Label Edit Popup; refer to Label Edit Popup on page 8-37.

• Directly edit a label. Use the following format:

type labelname: 

where type is start_label, subr, global subr, or global. 

The colon is part of the label. 

If type is omitted, the label is a local label. 

For more information about labels, refer to Kinds of Labels on page 6-35, Pattern 
Language Reference, Chapter 6. 

Label Rules

• In the normal mode, a label appears only on the first vector of a pair. 

• In the extended mode, a label may appear on any vector.

• In the SCIO or mux mode, a vector appears only on the first line of the vector.
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patgen Column

Overview

This column displays the pattern generator microcode, which is an opcode or control bits or 
both; refer to Control Bits on page 6-88, Pattern Language Reference, Chapter 6. 

Expanding the patgen Column

The patgen column can be expanded into its sub-columns: opcode column, plus one column 
for each control bit: clr_fail, icc, ifc, ign, mask, and stv; refer to Expanding and 
Collapsing Columns on page 8-49. Each control bit column displays Y or N, signifying 
whether the control bit is set for this vector; refer to Control Bits on page 6-88, Pattern 
Language Reference, Chapter 6. 

Editing the patgen Column

If the current cell supports microcode, this column displays microcode and a button. Edit the 
microcode by the following methods:

• In the cell, click the button to open the Patgen Microcode Edit Popup; refer to Patgen 
Microcode Edit Window on page 8-37.

• Directly edit the microcode. 

Microcode Rules

• In the normal mode, the microcode appears only on the first vector of a pair except for a 
mask control bit that supports microcode on any vector. 

•  In the extended mode, microcode may appear on any vector. 

• In the SCIO or mux mode, a vector appears only on the first line of the vector.
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tset Column

Overview

This column displays the tset (timing set) name or number for the vector; refer to tset 
(Timing Set) Data on page 6-39, Pattern Language Reference, Chapter 6. 

A dash (-) in this column signifies runtime repeat, which repeats the tset from the previously 
executed vector.

Requirements

• All tset names are declared in the Imports worksheet.

• Single pattern cannot contain both tset names and numbers.

• tset value must appear for every vector.

Editing the tset Column

If the current cell supports tset values, the column displays a tset and a button. Edit the tset 
values by the following methods:

• In the cell, click the button to list a drop-down list of tset values; all imported tsets names 
include a plus "-". Select one of them.

• Directly edit this column.

tset Rules

In the source pattern file, the tset may be part of the vector pin list, or it may be specified 
only on selected vectors:

• For a pin list:

a. tset column appears in the same position where $tset appears in the vector pin list.

b. $tset entry appears in the same position as on the Pin List worksheet.

• For selected vectors:

a. tset column appears after all pin data columns, 

b. $tset does not appear as on the Pin List worksheet.
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Pin Data Columns

Overview
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These columns list the pin names, pin group names, or channel numbers. Initially, the pin 
data columns are in the same order as the items on the Pin List worksheet. Columns 
containing only a pair of parentheses are unnamed groups. For information about the pin data 
values, refer to Symbolic and Numeric Pin Vector Data on page 6-41, Pattern Language 
Reference, Chapter 6. 

Some column headings have an appended colon and a code letter identifying the display 
radix. For example, abus:H is a pin group named abus displayed in hexadecimal. Available 
radices: S (symbolic), H (hexadecimal), B (binary), O (octal), and D (decimal). Default radix: 
symbolic; refer to Changing the Radix on page 8-48.

A dash (-) in this column means runtime repeat, which repeats the data for this column from 
the previously-executed vector.

Editing the Pin Data Column

If the current cell supports pin data, the column displays the pin data and a button. Pin data 
can be edited or changed without editing by the following methods:

• In the cell, click the button to open the Patgen Microcode Edit Popup; refer to Pins Edit 
Popup on page 8-75. This editing method is useful because PatternTool ensures the 
syntax for format, (symbol or numeric, drive or receive) radix, and symbols are correct.

• Directly edit the pin data. 

• Change the pin data states without direct editing: complementing data or swapping drive 
and receive data; refer to Changing Pin Data States on page 8-52.

Pin Data Rules

• In the mux mode, two multiplexed items appear in the same column: however, only the first 
item is named in the column header. The first vector line displays the data for the first item, 
and the second line displays the second (unnamed) item.

• In the SCIO mode, each io_valid or io_midband item requires two lines to display the data. 
The first line is either drive or receive, as specified on the Pin Setups worksheet.

comment Column

This column is for end-of-line comments. You can directly edit this column; refer to End-of-
line Comments on page 8-62.
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Label Edit Popup
Overview

This popup is opened from the label column on the Vectors worksheet.

For label requirements, refer to Vector Labels on page 6-34, Pattern Language Reference, 
Chapter 6. 

Creating a Label

1. Select a Label type: start, local, global, subr, or global subr.
2. In the Label name field, enter a label, containing only letters, digits, and underscores. It 

must begin with a letter.

3. As you enter a name, the List field displays the keyword, the name you are entering, and a 
terminating colon. Note that local label does not have a keyword.

4. If you enter an invalid character, the name disappears from the List field.

5. Do not enter the terminating colon; it is appended by PatternTool.
6. After entering a name, click Add. You can create another label in the same cell.

7. When you have finished, click OK.

Deleting and Modifying a Label

To delete an existing label, highlight the label in the List field and click Delete.

You cannot modify an existing label; instead, delete it and add a modified version.

Patgen Microcode Edit Window
Overview

This window is opened from the patgen column on the Vectors worksheet. If the column is 
expanded, you can also open it from the opcode column or any control bit column. For 
information about opcodes and control bits, refer to Vector Data on page 6-31, Pattern 
Language Reference, Chapter 6. 
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Window Elements

Enabled and Disabled Options in Patgen Microcode Edit

When you choose an opcode in the Opcode choice area of the dialog box, other areas of the 
dialog box are enabled or disabled, depending on the valid syntax elements for this opcode. 
For example, if the opcode you select does not take a label as an operand, the Label area is 
disabled.

Microcode Window

As you select or enter elements of the microcode, they are added to the Microcode field at the 
bottom of the window. You cannot directly edit this text, but you edit this information by 
selecting, deselecting, entering and deleting elements elsewhere in this window.

Enabling and Disabling the OK Button

Until you have entered a valid operand required by the opcode, the OK button is disabled. For 
example, if you select the repeat opcode, OK is disabled until you enter a valid number in 
the Number field. After you enter a valid operand, OK is enabled, and you can continue to 
edit the microcode.

+ Recommended order for entering selections in this window: opcode 
choice, loop register, label, number, condition, and control bits.

Opcode choice Box

1. In the Opcode choice area, select one of the four tabs listing the opcode group and then 
choose a specific opcode listed on the tab:

Repeat/Loop tab Branch tab Subroutine tab Miscellaneous 
tab

end_loop enable call clr_code

exit_loop end_module call_glo clr_flag

loop halt ccall set_code

mrepeat jmp_glo pop set_cpu

pipe_minus jump push set_glo
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2. Once you have chosen an opcode, other options for this opcode are enabled while invalid 
options are disabled.

+ If control bits without an opcode are required, select None.
3. After selecting the required option, click OK.

To clear the current opcode from the Microcode field and any operands and conditions, select 
None. Note that any currently-selected control bits are not cleared because control bits can be 
used without an opcode.

Loop Reg Box

For certain loop opcodes, you must select a loop register. In this case, select A, B, or C in the 
Loop Reg area. Note that register A is a stack, not a single register.

Label Field

If the opcode requires a label operand, enter a label name in the Label field for the selected 
opcode.

Number Field

If the selected opcode requires a numeric operand, enter a valid number for the selected 
opcode in the Number field.

Condition/Flag List Box

The title for this box depends on the selected opcode:

• For the clr_flag or set_cpu opcode on the Miscellaneous tab, this area is titled Flag List 
because the operands for these two opcodes are flags. You are not conditioning the 
execution of these opcodes—you are selecting the flags to be cleared or set for these 
opcodes.

pop_loop keep_alive resume set_pcf

repeat None return None

set_loop None

None

Repeat/Loop tab Branch tab Subroutine tab Miscellaneous 
tab
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• For a selected opcode accepting conditions or flags, the flags or conditions valid for the 
opcode are listed in the Condition or Flag List area. For more about conditions, refer to 
Conditional Statements on page 6-91, Pattern Language Reference, Chapter 6. 

All conditions or flag are listed as they appear in the Condition box:

and or

flag pcf !pcf

fail pass xext !xext

ext !ext xfail !xfail

cpuA !cpuA cpuC cpuD

cpuB !cpuB cpuD !cpuD
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Determine whether a single or compound flag or condition is required:

• Single Condition/Flag

To select a single condition or flag to execute the opcode, click the desired condition box. 
The condition or flag appears in the Microfield field with the following syntax:

if (condition) opcode 

• Compound Condition/Flag

To select a compound condition or flag to execute the opcode:

1. On Branch tab, select the enable opcode to start building a compound condition.

2. The Condition area lists the valid operands. The selecting conditions here do not condition 
the execution of the enable itself. You can select any number of the conditions except 
flag. Complementary conditions, such as cpuA and !cpuA, or fail and pass, cannot both 
be selected.

3. Choose the logic conditions for the compound, if required: and or or.

Control Bits Box

Control bits can be added to any vector—an opcode is not required. All control bits are listed 
as they appear in the Control Bits box:

For more information about control bits, refer to Control Bits on page 6-88, Pattern 
Language Reference, Chapter 6. 

Control Bit Restrictions

• clr_cond bit is enabled only when the opcode is conditioned with exit_loop, jmp_glo, 
jmp, call, call_glo, resume, or return.

• ign control bit is disabled when the halt opcode is selected.

mask icc

ign ifc

stv clr_fail

clr_cond
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Pin Data Edit Window
Overview

This editing dialog box can be opened from any pin data column of the Vectors worksheet. In 
the SCIO or mux modes, the second row of a vector has columns that do not support data; 
thus, the edit window is not available for those cells.

Each pin data format enables different editing capabilities.

For more information, refer to Symbolic and Numeric Pin Vector Data on page 6-41, Pattern 
Language Reference, Chapter 6. 

Pin Data Field

The pin data for the currently-selected format is displayed in the Pin Data field at the bottom 
of the panel. You can edit this data by inserting or deleting characters. If you enter invalid 
characters, the OK button is disabled.

You can also use the panel controls to edit the data in the Pin Data area:

• Use the left-arrow and right-arrow buttons above the window to select a character to edit. 
If no character is highlighted, click one of these buttons to select a character.

• Use the up-arrow and down-arrow buttons on the left side of the window to select the pin 
data valid for the currently-selected Format and Radix. The selected Drive and Receive 
formats also affect the currently-selected Radix of the pin data.



PatternTool 8

8-43Software Release 1.0
Part Number 560-968-00, Revision 1

Vectors Worksheet

8
Pa

tte
rn

To
ol

Format Area

The selected format determines what options are enabled; thus, you should choose the format 
first:

• Symbolic—enables the Symbolic States area. In the extended mode, all buttons are enabled; 
in the normal mode, D, S, E, and R are not enabled. When you click on one of these buttons, 
the current character in the Pin Data area is changed to that state, and the next pin data 
character is highlighted. Use the left-arrow and right-arrow buttons above the Pin Data area 
to select the character to edit.

If you use the mouse to select several characters in the Pin Data area, clicking Symbolic 
States button changes all selected characters to that value.

• All same—sets all pins to the same symbolic value. You can use a Symbolic States button 
to set the value. The Pin Data area displays the single symbolic value, preceded by a 
period.

• Drive/Receive—These formats use radix values. If you select one of these formats, the 
Radix options are enabled.

Radix Area

The following numeric options are enabled when the Drive or Receive format is selected:

• Binary

• Octal

• Decimal

• Hexadecimal

Use the left-arrow and right-arrow buttons above the Pin Data area to select the radix 
character to edit. You can then use the up-arrow and buttons to display all valid values for 
that character.
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Symbolic States Area

Selecting the Symbol format enables the Symbolic States area, which displays the following 
state values:

+ In the extended mode, all state buttons are enabled. In the normal 
mode, the D, S, E, and R states are not enabled.

When you click on one of these buttons, the current character in the Pin Data area is changed 
to that state, and the next pin data character is highlighted. Use the left-arrow and right-arrow 
buttons above the Pin Data area to select the character to edit.

If you use the mouse to select several characters in the Pin Data area, clicking the Symbolic 
States button changes all selected characters to that value.

0 1 L H

X M V - (minus)

D S E R
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Editing the Vectors Worksheet
Editing Vectors Columns

Some vector columns have edit popups to assist you in editing the columns; refer to Vectors 
Worksheet Columns on page 8-31.

The Vectors worksheet has several columns with unique editing features; however, the 
general editing features for all worksheets also apply to the Vectors worksheet:

• Selecting Data to Edit on page 8-19

•  Hiding and Exposing Columns on page 8-11

• Editing Cell Data on page 8-23

• Using Find, Replace, and Goto on page 8-27

In addition to the general editing features, only the Vectors worksheet supports the following 
editing features:

• Changing the Appearance of the Vector Column on page 8-47

• Changing the Radix on page 8-48

• Expanding and Collapsing Columns on page 8-49

• Creating Pin Groups on page 8-51

• Changing Pin Data States on page 8-52

• Cutting, Copying, and Pasting Vector Data on page 8-56

• Inserting and Deleting Vectors on page 8-59

• Adding and Editing Comments on page 8-60

Editing MTM (Memory Test Module) Data

MTM (Memory Test Module) data may require special editing considerations; refer to 
Memory (MTM) Data on page 8-63.
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Using Find/Goto on the Vectors Worksheet

In addition to the general search features of Find/Goto, only the Vectors worksheet supports 
the following additional searching features:

• Go to a specific vector:

1. On the Find/Goto menu, select Vector from the Goto submenu. You can also use the 
shortcut F5 key. The Go To Vector dialog box opens.

2. In the Go To Vector dialog box, enter the number of the vector you want to go to in the Enter 
Vector Number box. The number must be an integer. For two-line vectors with vector 
numbers like 3.1 and 3.2, entering the integer, such as 3, goes to the first of the two vector 
lines.

• Go to a specific label:

1. On the Find/Goto menu, select GotoLabel. The Go To Label dialog box opens.

2. In the Go To Label dialog box, enter the name of the label, but not the label type, such as 
global or subr, in the Enter Label Name box. Only the labels in the label columns are 
searched for; references to labels are not searched for, such as the operand of a jump 
opcode. To find references, use Find Text.

Saving an Edited Pattern File

When you save an edited pattern file with the Save or Save As command, it is checked for 
errors. If errors are found, the errors are written to a Message window; refer to the following 
topics for more information:

• File Checking on page 8-14

• Message Window on page 8-16
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Changing the Appearance of the Vector Column

Overview

Certain commands and operations change the appearance of the selected columns of vector 
data on the Vectors worksheet; however, the data in the columns is not changed:

• Changing the Radix on page 8-48

• Expanding and Collapsing Columns on page 8-49

• Creating Pin Groups on page 8-51

In addition, the appearance of columns on any worksheet, including the Vectors worksheet, 
can be changed by hiding, exposing, resizing, or moving columns; refer to Changing the 
Column Appearance on page 8-10.

Selecting a Column

To change appearance of a column, select a cell in the column by clicking on it. The entire 
column is selected. You do not have to select all individual cells in the column: if you select 
an entire row by left-clicking in the row header in the far left column, every column is 
selected.
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Changing the Radix

Overview

Pin data can be displayed in different radices:

• Symbolic

• Numeric: Binary, Octal, Decimal, and Hex 

The current radix is displayed in the column heading, as a code appended to the pin or group 
name. If no radix code is appended, the default radix is Symbolic. For example: abus:H

where abus in the pin group, and :H indicates hexadecimal representation.

For more information, refer to Symbolic and Numeric Pin Vector Data on page 6-41, Pattern 
Language Reference, Chapter 6. 

Changing the Radix

1. Select a column by selecting at least one cell in the column, refer to Selecting Data to Edit 
on page 8-19.

2. On the Column menu, from the Radix submenu, select Symbolic, Binary, Octal, Decimal, 
or Hex.

+ Only pin data columns in the Vectors worksheet support radix.
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Expanding and Collapsing Columns

Overview

You can change how PatternTool displays the pin data or patgen microcode by displaying 
the pin data in individual columns for each pin in a pin group or the opcode code and each 
control bit.

If a pin data column represents a pin group, you can expand the group to display each pin in 
the group, one column per pin. Or, you may prefer to expand the pin data because editing 
individual pins is easier than changing a value representing the data for the entire pin group.

You can also expand the column for the patgen microcode to one opcode column and one 
column for each control bit: clr_fail, icc, ifc, ign, mask, and stv; refer to Control Bits on 
page 6-88, Pattern Language Reference, Chapter 6.  The expanded control bit columns will 
display Y and N, signifying whether the control bit is set. You can directly manipulate the 
expanded control bits; refer to Changing Pin Data States on page 8-52.

Expanding a Pin Data Column

To expand a column:

1. Select the column by selecting at least one cell in it, refer to Selecting Data to Edit on page 
8-19.

2. On the Column menu, click Expand.
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Collapsing a Pin Data Column to a Single Column

To collapse the expanded columns to their original single column:

1. Select at least one cell from any of the expanded columns, refer to Selecting Data to Edit 
on page 8-19.

2. On the Column menu, click Collapse.

Collapsing a column returns the expanded columns to their original unexpanded grouping. If 
you select a subset of the expanded columns and collapse it, the columns in the subset are 
collapsed to the original column grouping.

Be aware that expanding and collapsing columns containing new column groupings may 
result in unexpected results. For instance, assume you expand a column, and then click the 
Make Group command on the Column menu to create a column group that is a subset of the 
expanded columns. When you click Collapse, the individual columns may not collapse to the 
original column grouping before the new column grouping was created. For more 
information about creating column groupings, refer to Creating Pin Groups on page 8-51.

Column Headings

Expanding a column may truncate the headings of the new columns because the headings are 
too wide. To display the entire heading, such as control bit headers, you can increase the 
height of the column header by resizing the top row containing the column headers; refer to 
Resizing the Row Height on page 8-13.
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Creating Pin Groups

Overview

You can display pins in new pin groups, even if these groups are undefined in the pin list. 

Note the following restrictions and requirements:

• Only pin or channel data columns can form a new group. 

• Pins in the mux or SCIO mode cannot be grouped with pins not in the same mode.

• Columns of individual pins or pin groups can be grouped.

• A pin group can be expanded into individual pin columns, and then the individual columns 
can be grouped into new pin groups.

To combine pins or pin groups into a new group:

1. Select at least one cell in each of the columns to be grouped, refer to Selecting Data to Edit 
on page 8-19.

2. On the Column menu, click Make Group. The selected columns are grouped into a single 
column. The column header contain a list of all items, in parentheses.



PatternTool8

8-52 Software Release 1.0
Part Number 560-968-00, Revision 1

Vectors Worksheet

Changing Pin Data States

Overview

The data in a selected range of cells can be changed, without manually editing the individual 
cells. The pin data states underlying a cell are changed, not the textual representation of the 
cell, such as its radix.

Selecting Pin Data Cells to Change

The cells must be selected before they can be edited; refer to Selecting Data to Edit on page 
8-19. One cell, a rectangular range of cells, non-adjacent cells, an entire row or column of 
cells, or all cells in the grid can be selected. If you select cells whose pin data state cannot be 
changed, PatternTool ignores those cells, without issuing a warning.

Changing Pin Data States in Selected Cells

• Complementing on page 8-53 

• Swapping the Drive and Receive Data on page 8-54

• Replacing the Pin States in Pin Data Cells on page 8-54
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Complementing 

Complementing the Pin Data States

To change the pin states to their complement, such as L to H or 1 to 0:

1. Select the pin data cells, refer to Selecting Data to Edit on page 8-19.

2. On the Edit menu, select Complement. You can also use the  button on the Edit toolbar.

Changing each pin data state to its complement, such as 0 to 1, 1 to 0, L to H, and H to L, 
has no effect on the other data codes.

Complementing the Control Bits

To complement the control bit cells:

1. Expand the patgen microcode column into an opcode column and control bit columns; refer 
to Expanding and Collapsing Columns on page 8-49. If the patgen microcode column is not 
expanded, the Complement command does not affect the control bits.

2. Select the control bit cells, refer to Selecting Data to Edit on page 8-19.

3. On the Edit menu, select Complement. You can also use the  button on the Edit toolbar. 

In this case, Y is changed to N and N to Y. 

In the normal mode, the opcode and most control bits are used only on the second vector of 
each vector pair. Also, only the mask control bit is allowed on the first vector of the pair. For 
these reasons, in the normal mode the mask control bit on only the first vector of a vector pair 
can be complemented, while all bits on the second vector are affected.
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Swapping the Drive and Receive Data

Swapping the drive and receive data changes the data from 0 to 1, 1 to 0, L to H, and H to L. 
For a radix other than symbolic, the .d and .r indicators are swapped, such as .d1F becomes 
.r1F. Swapping has no affect on other symbolic datacodes or on control bits.

To swap the drive and receive data:

1. Select the pin data cells, refer to Selecting Data to Edit on page 8-19.

2. On the Edit menu, click Swap 0/1 With L/H. You can also use the  button on the Edit 

toolbar.

Replacing the Pin States in Pin Data Cells

Overview

You can replace one set of pin states of pin data cells with another set by specifying the states 
to be changed and those to be substituted. Each state can be replaced with a specific single 
state, or all states can be replaced with a single state. For example, you can specify that 0 and 
L should be replaced with 1 and H, or that X should replace H, M, and V.

Valid values for both From States and To States fields:

0 1 L H M V X - 2 D S E R

For information about the meaning of these states, Symbolic and Numeric Pin Vector Data on 
page 6-41, Pattern Language Reference, Chapter 6.
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Replacing States

To replace states:

1. Select the pin data cells, refer to Selecting Data to Edit on page 8-19.

2. On the Edit menu, click Replace States. The Find & Replace States dialog box appears.

3. In the From States field, enter the state or states to be searched for and replaced. You can 
type in the states. Or, you can click on Drive States, Receive States, or All States button to 
have those states appear in the From States field. If you use the buttons to enter the states, 
you can edit the From States field, if needed.

4. In the To States field, enter the state or states to be substituted for the state listed in the From 
States field. You have the following options:

• Enter either one value, or the same number of values as in the From States field.

• If you enter a n (number) of states in both the From States and To States fields, the nth From 
States value is replaced by the nth value in the To States field.

• If you specify only one value in the To State field, all values in the From States field are 
replaced by a single To States value.
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Cutting, Copying, and Pasting Vector Data

Overview

The Vectors worksheet supports the standard cut, copy, and paste operations; refer to Editing 
Cell Data on page 8-23. In addition, this worksheet supports several additional pasting 
features, because the Vectors columns have special requirements for any data pasted into 
them.

Standard pasting gets the data currently on the clipboard and pastes it into the vector. 
However, certain cases may require a special paste operation due to how the vector data was 
copied to the clipboard. The appropriate paste command depends on the contents of the 
clipboard. Data is copied to the clipboard in one of three different formats, which determines 
the proper paste command to use:

Clipboard Contents Use this paste command:

Text Paste Text

Pin data Paste Pin Data

Whole row Paste Rows

+ Pasting non-adjacent cells: select multiple non-adjacent cells by 
holding down the Ctrl key while clicking on individual cells. 
Although you can cut non-adjacent cells to delete their contents, 
PatternTool does not paste to the selected non-adjacent cells.
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Paste Text

This command in the Edit menu copies data from a different application, such as Excel. You 
can also use the  button on the Edit toolbar.

If the replacement or pasted text does not compile within the cell, a message box appears. 
You are prompted to attempt the paste operation anyway. If you answer no, the current cell is 
skipped, and the paste operation goes to the next cell.

The behavior of Paste Text depends on the clipboard data:

• To paste pin data with Paste Text, you should have correctly copied the data to the 
clipboard: same pin type and, for pin groups, the same number of pins per group. In some 
cases, however, the paste operation may succeed even if the number of pins do not match.

• Clipboard data contains row markers. A row marker signifies that data has been copied to 
the clipboard as one or more complete rows:

If the clipboard data contains row markers, Paste Text is the same as Paste Rows.

If the clipboard has no row markers, Paste Text replaces each cell within the 
selected area with the clipboard data.

• If the clipboard data has extra rows or columns, they are ignored during pasting. If more 
rows or columns are selected than those in the clipboard data, these excess rows, which are 
referenced from the far right and bottom rows, do not receive any pasted data.

Paste Rows

This command in the Edit menu inserts new rows are above the selected row when the entire 
grid is selected, or rows are appended to the bottom of the grid when an entire column is 
selected. 

This paste command has the following requirements:

• Clipboard data must be in a row format—an internal row format or text row format.

• Clipboard data must have enough data for all the columns of the grid.

Paste Pin Data

This command in the Edit Menu pastes pin data or control bit data that is copied from an 
expanded patgen column that displays the opcode and control bits. You can also use the  
button on the Edit toolbar.

This command is less restrictive than the other paste commands:
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• Selected area must have the same number of pins and of vector rows as the clipboard data; 
however, the pin groups do not have to be equal. For example, data can be copied from 2 
pin groups with 6 pins each, and be pasted to 4 pin groups with 3 pins each, as long as the 
total number of pins and rows match.

• Number of columns is not significant. 

• Data from one pin column can be pasted to another if the symbolic pin states are 
compatible, even if the pins have different modes. If you attempt to paste an invalid state, 
such as V to an io_midband pin, an error is reported.

• If the copied data includes any comment rows, the comment rows are not pasted; only pin 
data is pasted.
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Inserting and Deleting Vectors

Overview

Improperly inserting or deleting a vector row may invalidate the entire pattern file. If the 
pattern file was compiled in the normal mode, opcodes and labels can appear only on every 
other vector. Consequently, if you insert or delete an odd number of vectors, this alternating 
pattern will be disrupted. In this case, the labels and opcodes appearing on illegal vectors are 
highlighted in pink until you restore the proper number of vectors.

Inserting Vectors in a Pattern FIle

+ Copying and pasting vectors (Cutting, Copying, and Pasting Vector 
Data on page 8-56) may be a more efficient method than inserting 
new ones because you can usually edit less data in the copied vectors 
than editing all default values of the inserted data, such as, runtime 
repeat.

1. On the Edit menu, under the Insert Mode submenu, select where you want to insert the new 
rows: Insert Before Selection, Insert After Selection, or Insert Before Current Cell.

2. On the grid, select the same number of rows as the number of rows to insert. For example, 
select 5 current rows to insert 5 rows. Select a row by highlighting at least one cell in the 
row.

+ In the SCIO or mux mode, each vector is represented on two lines 
numbered n.1 and n.2. You cannot insert a new vector between the 
lines of a two-line vector. 

3. After selecting the correct number of rows, select Insert Vectors on the Edit menu. The new 
vectors have default values: no label or patgen microcode, each pin data cell is set to - 
(minus sign), which is runtime repeat of the data from the previous vector. In the SCIO 
mode, the drive cell is set to 0, and the receive cell is set to X.

4. Once the new vector is inserted, you can edit the Vectors worksheet to enter non-default 
data; refer to Editing the Vectors Worksheet on page 8-45

Deleting Vectors from a Pattern File

1. Select the vectors by selecting at least one cell in the row; refer to Selecting Data to Edit 
on page 8-19.

2. On the Edit menu, select Remove Rows. If you select multiple non-adjacent cells by holding 
down the Control key while clicking on the cells, Remove Rows is disabled; the command 
can remove only adjacent rows in a single operation.
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Adding and Editing Comments

Overview

The Vectors worksheet provides two columns for displaying comments:

// Column next to the row header column containing the row 
numbers. It displays block comments, which take up the entire 
line; however, you do not use this column to enter the block 
comments; refer to Block Comments on page 8-61.

comment By default, this far-right column displays end-of-line comments, 
which appear on the same line as the vector and are terminated 
by the end of the line; refer to End-of-line Comments on page 8-
62.

These columns are hidden if the pattern file was compiled without saving the comments; 
refer to save_comments Option on page 8-60. To expose the comments, refer to Hiding and 
Exposing Columns on page 8-11. 

save_comments Option

The Pattern Compiler saves any comments you add to a compiled .pat file only if the 
save_comments option is enabled before compilation. When you save a pattern file, 
PatternTool determines whether the pattern file has comments and checks the setting of 
save_comments. If it is disabled, PatternTool prompts you to set it to yes so the comments 
can be saved. If you enter no, added comments are discarded, and the two columns for 
comments are hidden.

To set the save_comments option in a pattern file:

1. On the Options worksheet, click save_comments on the Value column.

2. From the drop-down list on the Value column, select yes.
3. To display the comment columns on the Vectors worksheet, click the Expose command in 

the Column menu on the highlighted $// and $comment columns. For more information, 
refer to Hiding and Exposing Columns on page 8-11.
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Block Comments

Overview

Block comments in the Vectors worksheet are displayed in the // column. This column is next 
to the next to the column of vector numbers. You do not add comments to the // cell of a row 
that already contains vector data because anything you enter in that cell will be discarded.

Block comments fill the entire line. Each row of block comments extends across the entire 
grid, with no dividing lines for columns. Comments are numbered m.C.n, where m is the 
vector number of the vector preceding the block comment, C is a comment, and n is the line 
number within this block comments, starting at 0. For example, 5.C.3 is the fourth comment 
line after vector number 5. Even though the numbering of comments is based on the rows 
preceding them, they are actually associated with the preceding vector.

For header comments, the vector number (m) is -1; for example, -1.C.10.

Even though block comments seem to extend across the entire grid, they are stored only in 
the // column. Consequently, if you copy a pin data cell range extending above and below a 
block comment, the comment is not included when you paste the pin data.

If this column is moved, comments are not displayed and editing of existing comments is 
disabled. 

Adding Block Comment Rows

1. On the Edit menu, under the Insert Mode submenu, select where to insert the new rows: 
Insert Before Selection, Insert After Selection, or Insert Before Current Cell.

2. On the grid, select the same number of comment rows as the number of rows to insert. For 
example, select 5 current rows to insert 5 comment rows. Select a row by highlighting at 
least one cell in the row.

3. After selecting the correct number of rows, select Insert Comments on the Edit menu to add 
the selected number of comment rows. 
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Editing Block Comments

Any text except a newline is permitted within a block comment. Entering a new line produces 
unpredictable results; thus, the recommended method is to continue a comment on a 
succeeding comment row instead of beginning a newline.

PatternTool starts each block comment row with the comment bars //. You do not need to 
maintain proper comment delimiters because PatternTool adds any needed delimiters to the 
comment rows when you save a file.

To use the /* and */ delimiters in block comments: 

1. First line of the block comment must start with /*

2. Last line must end with */

3. No */ between the beginning and ending comments. 

If these rules are violated, PatternTool converts the comments to // style.

Header, Vector, and Trailer Comments

The Pattern Compiler recognizes three kinds of block comments:

• header comment at the start of the pattern file

• comment preceding an individual vector

• trailer comment at the end of the file

To distinguish between a header comment and a comment preceding the first vector, 
PatternTool ends a header comment with a comment row containing only a period (.).

End-of-line Comments

End-of-line comments are in the comment column. The comment is on the same line as a 
vector. If a vector requires two lines, such as for mux_mode or SCIO, a comment can appear 
only on the first line.

You can enter end-of-line comments without delimiters. PatternTool adds any missing 
comment delimiters when you save the file.

If a comment starts with /* and contains a */ before the end of the text, the text is truncated 
after the */.
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Memory (MTM) Data

Overview

A pattern file containing MTM (Memory) data is specified on the Vectors worksheet. 

Memory Data Columns

If a pattern file contains memory (MTM) data, several columns for the MTM opcodes are 
added to the Vectors worksheet. These columns are listed below.

+ The column name is usually the same as opcode name; however, if 
the column name differs from the opcode name, the proper opcode is 
in parenthesis. Opcode syntax is listed in MTM (Memory) Opcodes 
on page 6-65, Pattern Language Reference, Chapter 6.

Column Description

xalu ALU for X counters

xa, xb, xc, xd, Control an X address counter

xdevadr X counter to address the DUT

xena (load_xenable) Change the X address enable register

yalu ALU for Y counters

ya, yb, yc, yd Control a Y address counter

ydevadr Y counter address to the DUT

yena (load_yenable) Change the Y address enable register

zalu ALU for Z counters

za, zb Control an X address counter

zdevadr Z counter to address the DUT

zena (load_zenable) Change the Z address enable register

dga, dgb Control the 32-bit data generator (dgen) counter
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Every MTM column has a value on every vector because every MTM opcode in a pattern file 
is programmed on every vector. If an MTM opcode is not explicitly included on a vector, a 
default opcode is used; consequently, PatternTool displays a value for every MTM column.

dg_sel 32-bit data counter (dgen) for data generation

dgroup Select a data group (2-bit dgen)

dset Select a data group (2-bit dgen)

xdgadr X address counter as input to 2-bit dgen

ydgadr Y address counter as input to 2-bit dgen

alu const (alu_const) Constant for ALU expression

frame Select the frame select bit

sr reg (sr_reg) Control the serialization register.

wr db (wr_dbm) Select DBM on the fly as the alternate data 
source instead of the Address Data Generator

dbm en (dbm_enable) Enable masking of DBM output

cap err (capture_errs) Enable error capturing to the ECR

vihh0, vihh1, vihh2, vihh3 
(vihhenX)

Enable VIHH control of the pin levels.

dps0, dps1, dps2, dps3 Control DPS ratcheting on selected DPS.

acc 0 (dbm_acc_zero) Enable DBM accumulate zeros mode

iddsync Control the Ipeak current measurement

learn_dut Enable DBM learn-DUT mode

errors (ecr_boe) Control branching on error

Column Description
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Hiding and Exposing MTM Columns

You can hide those columns containing MTM data. Click Hide MTM on the Column menu to 
hide the MTM columns without deleting them. This command is like the regular Hide 
command except that you do not have to select the MTM columns to hide. When MTM 
columns are hidden, click Expose MTM to display only the MTM columns; refer to Hiding 
and Exposing Columns on page 8-11.

Editing MTM Data

How you edit the MTM data depends on the complexity of the data expression:

• Opcodes with valid values—Most cells in MTM columns have a button to display a drop-
down list of the valid values for a specific opcode. These lists are provided for opcodes with 
a set of simple values.

• Opcodes with no values—They are either included or omitted on a vector. They are 
specified on a drop-down list by Y (yes, include) and N (no, omit).

• Opcodes with complex expressions—cannot be configured by using a drop-down list, such 
as xalu, yalu, zalu, dgalu (16-bit only), and alu_const. Edit these opcodes by using the 
MTM Microcode Edit Popup on page 8-66.
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MTM Microcode Edit Popup

Overview

The following techniques invoke the MTM Microcode Edit popup from a MTM cell:

1. Click on the right-arrow in a MTM cell.

2. Under Edit menu, select Cell Edit Popup.

3. Press the F7 key.

You can use the MTM Microcode Edit popup to edit all MTO microcodes for a vector, not 
just the opcode for the one column where you invoked the popup; however, only those 
opcodes valid for the data generator specified on the Instruments worksheet are displayed. 
Each MTM opcode has a corresponding control, such as a checkbox, combination box, or 
input box, for changing the opcode setting.

For information about opcodes, refer to MTM (Memory) Opcodes on page 6-65, Pattern 
Language Reference, Chapter 6. 

MTO microcode: display

The read-only MTO microcode: field at the bottom of the popup shows the current MTO 
microcode, including any edits. It displays the opcodes having non-default values. If you 
specify a non-default value for an opcode, the opcode and value appear in the display. If you 
change a non-default to a default value, the opcode disappears from the display.

You cannot directly edit this field. This field is changed by manipulating the controls on the 
popup. You can highlight and copy the contents of the field, and then paste it into another 
file, such as an ASCII pattern file.
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Checkbox, Combo Box and Text Box Controls

+ For information about valid values for the MTM opcodes, refer to 
MTM (Memory) Opcodes on page 6-65, Pattern Language Reference, 
Chapter 6. 

Checkbox These controls are for opcodes that do not accept values, but are 
either included or omitted on a vector. For example, you either 
include or omit the capture_shift opcode. Checking the box 
includes the opcode; not checking the box omits it. By default, 
these opcodes are omitted. On the Vectors worksheet, the 
columns for these opcodes have either Y (include) or N (omit).

Opcodes with checkboxes: load_xenable, load_yenable, 
load_zenable, wr_drm, dbm_enable, capture_errs, 
dbm_acc_zero, vihhen0, vihhen1, vihhen2, vihhen3, 
learn_dut, and iddsync.

Combo Box These controls are for the opcodes with a set of valid values. For 
example, xa opcode is set to hold, inc, inc_link, and others. 

Select a value from the drop-down list for the following 
opcodes: xdevadr, ydevadr, zdevadr, dset, dgroup, 
xdgadr, ydgadr, sr_reg, xa, xb, xc, xd, ya, yb, yc, yd, 
za, zb, dgsel, frame, dps0, dps1, dps2, dps3, and 
ecr_boe.

Text Box Sets an integer constant for the ALU expression alu_const. 
Valid range: 0 to 65535.

+ For the text boxes for the xalu, yalu, zalu, and dgalu opcodes, 
refer to ALU Tabs: xalu, yalu, zalu, dgalu on page 8-68.
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ALU Tabs: xalu, yalu, zalu, dgalu

These tabs are for creating expressions for the xalu, yalu, zalu, and dgalu opcodes, only 
for the 32-bit data generator. 

All tabs include checkboxes to invert the expression and to link the X and Y ALUs; however, 
on the dgalu tab, link, xdevadr, and ydevadr are never enabled.

The read-only xalu, yalu, and zalu fields display the current values for each opcode for 
whatever tab is exposed.

Each ALU tab enables different buttons and checkboxes for specific operations. Each ALU 
tab has three sets of radio buttons:

+ On the dgalu tab, link is never enabled, and xdevadr and ydevadr are 
never enabled.

• Operand 1—To assign Operand1 as the ALU value, select nop as the Operation. With this 
selection, the Operand 2 buttons are disabled; invert box is enabled; link is disabled.

• Operation to be performed:

a. Arithmetic operation (+, -) accepts both operands. Also, invert box is disabled; link is 
enabled.

b. Logical operation (and, or, xor) accepts both operands. Also, invert box is enabled; link 
is disabled.

c. For arithmetic or logical operand, Operand 1 must be one of the counters; the other 
buttons are disabled.

d. Shift operation (<<1, >>1) uses only Operand 1. Operand 2 buttons are disabled. 
invert box is disabled; link is enabled.

• Operand 2—selects the additional operands as required.

Applying the MTM Microcode Edits

Apply the edits to the MTM microcode by clicking the OK button, which is enabled only if 
the integer in the alu_const input box is between 0 to 65535.
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Overview
The remaining worksheets are editable. The Pin List and Pin Edit worksheets are not directly 
editable; instead, you open an edit worksheet for each one; refer to Pin Edit Worksheets on 
page 8-69.

All of the general editing features apply to these worksheets; refer to Editing with 
PatternTool on page 8-18. In addition, each worksheet has a specific editing features:

• Pin List Worksheet on page 8-70

• Pin Setups Worksheet on page 8-72

• Options Worksheet on page 8-76

• Imports Worksheet on page 8-79

• Instruments Worksheet on page 8-80

Pin Edit Worksheets

You do not directly edit the Pin List worksheet and Pin Setups worksheet worksheets; instead, 
you open an edit popup for each worksheet, make any changes on the edit worksheet, and 
then use the edit worksheet to update the actual worksheet; refer to Pin List Edit Worksheet 
on page 8-71 and Pin Setup Edit Worksheet on page 8-74.

The Pin Edit worksheet is useful for validating edits because your worksheet can temporarily 
be in an invalid state when adding a pin to one row before deleting it from another. The edit 
worksheet is not validated until you actually try to update the worksheet.
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Pin List Worksheet
Overview

The Pin List worksheet displays the list of pins for the vector data. These pin lists are used by 
the Vectors worksheet for assigning the data to each pin. The pin list is based on the pins 
listed in the vector statements in the pattern file; refer to Vector Statement on page 6-30, 
Pattern Language Reference, Chapter 6. 

Name Column

The Name column specifies the pin, pin group, or channel. A list of comma-separated items 
creates an unnamed group. You can enter the keyword $tset in one row to designate the 
column in which the tset (timing set) name or number will appear.

You can add or edit any pin name or group name in the pin list by directly editing the item or 
by using the Pin List Edit popup; refer to Pin List Edit Worksheet on page 8-71.

Radix Column

You can directly enter a valid display radix or use the drop-down list to select a display radix:

S = symbolic

B = binary

O = octal

D = decimal

H = hexadecimal

For $tset, Radix is set to D.

Pin Count Column

The Pin Count column displays the number of pins or channels in the items listed in the 
Name column. For $tset, the number is 0.

You cannot edit the Pin Count value. PatternTool updates this value for the correct number 
of pins or channels in the Name column.
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Pin List Edit Worksheet

1. On the Pin List worksheet, select Edit Pin List from the Edit menu. A Pin List Edit 
worksheet is created because you cannot directly edit a Pin List worksheet. Any changes to 
the worksheet during editing appear in blue. The Undo and Redo commands are enabled.

2. To create a new pin list item, insert a new row, refer to Inserting and Deleting Rows on page 
8-26.

3. To delete an item, delete the row containing the item, refer to Inserting and Deleting Rows 
on page 8-26. 

4. To edit an item in the Name column, use one or both of the following methods:

a. To edit a selected Name column with the Pins Edit popup, click the arrow in the Name 
column. A popup opens. Use the popup to add or delete pins or groups; refer to Pins 
Edit Popup on page 8-75.

b. You can directly edit an existing item. If you type more than one item into a single cell, 
surround these items with parentheses so they are recognized as an unnamed group. If 
you use the edit popup to edit an unnamed group, PatternTool adds the parentheses.

c. If you have used the Read Pinmap command, you can edit any name defined in the 
pinmap; refer to Reading the Pinmap on page 8-76. You can also use the value $tset, 
which is available on the edit popup.

5. After you finish editing, select Update Pin List on the Edit menu to apply the edits to the 
actual Pin List worksheet. To cancel editing, select Abort Pin List Edit.

+ Any errors from updating the worksheet are written to the Message 
Window on page 8-16.

Restrictions

• An item on a pin list can be moved from one unnamed group enclosed in parenthesis to 
another group.

• A row can be added to move a pin out of a group.

• A new group name can be added if it is in a pinmap already loaded; however, you cannot 
add new pins. 

• Set of all pins used must not change; but, you can reorganize the existing items.
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Viewing Updates to the Vectors Worksheet

Changes to the Pin List worksheet are not immediately updated in the Vectors worksheet. To 
view the updated changes, open a new window by selecting New Window on the Window 
menu. The Vectors worksheet in the new window will use the updated pin list.

Pin Setups Worksheet
Overview

The Pin Setups worksheet displays the special modes for pins defined in the pin_setup 
statement in the pattern file. For information about this statement, refer to Required pin_setup 
Statement on page 6-46, Pattern Language Reference, Chapter 6. 

Name Column

This column specifies the pin, pin group, or channel with the special mode. A list of comma-
separated items surrounded by parentheses creates an unnamed group.

You can add or edit any pin name or group name in the pin list by directly editing the item or 
by using the Pin List Edit popup; refer to Pin Setup Edit Worksheet on page 8-74.

Mode Column

Use the drop-down list to specify one of the following modes:

• mux

• io_midband

• io_valid

• high_voltage

• freq_count

+ You cannot change a pin into or out of the io_valid or io_midband 
mode: the pin must stay in the SCIO mode; thus, if a pin is already in 
io_valid mode, you can change it to io_midband, and vice versa.

Effects of Changing a Pin Setup

Changing a pin setup can affect the pin data states on the Vectors worksheet:
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• Specifying a mux_mode pin setup causes PatternTool to change the format of the 
Vectors worksheet to support two-line vectors, those with rows numbered n.1 and n.2. If all 
such pin setups are removed, the Vectors format changes from two-line to one-line vectors.

• By changing the mode from io_midband to io_valid, PatternTool will change any pin 
data with the value M to X; and any X will be changed to V; if you change io_valid to 
io_midband, V will be changed to X and X will be changed to M.

IO: Drive First Column

This column requires a value if the Mode column is io_midband or io_valid. Use the drop-
down menu to select a valid value:

yes—drive data is specified first in the pattern.

no—receive data is specified first in the pattern.

blank (empty)—removes a value from the selected cell.

Mux: Alt Pins Column

This column requires a value if the Mode column is mux. The pins specified in this column 
are multiplexed with the pins specified in the Name column. A list of comma-separated items 
surrounded by parentheses creates an unnamed group.

You can add or edit any pin by directly editing the item or by using the Pins Edit Popup on 
page 8-75.

Choices for the final two columns do not depend on the Mode value. For example, you can 
enter a valid value for Mux: Alt Pins even if Mode is not mux; thus, you can edit the columns 
in any order because the columns are not validated until you try to update the pin setup.
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Pin Setup Edit Worksheet

1. On the Pin Setup worksheet, select Edit Pin Setups from the Edit menu. A Pin Setup Edit 
worksheet is created because you cannot directly edit a Pin Setup worksheet. Any changes 
to the worksheet during editing appear in blue. The Undo and Redo commands are enabled.

2. To create a new pin setup, insert a new row; refer to Inserting and Deleting Rows on page 
8-26. 

3. To delete a pin setup, delete the row with the item; refer to Inserting and Deleting Rows on 
page 8-26.

4. To edit a selected Name column, use one or both of the following methods:

a. To edit a selected Name column with the Pins Edit popup, select click the arrow in the 
column. This popup helps you in adding or deleting pins or groups; refer to Pins Edit 
Popup on page 8-75.

b. You can also directly edit an existing item. If you type more than one item into a single 
cell, surround these items with parentheses so they are recognized as an unnamed 
group. If you use the edit popup to edit an unnamed group, PatternTool adds the 
parentheses.

c. If you have used the Read Pinmap command, you can edit any name defined in the 
pinmap; refer to Reading the Pinmap on page 8-76. You can also use the value $tset, 
which is available on the edit popup.

5. After you finish editing, on the Edit menu, select Update Pin Setups to apply your changes 
to the actual Pin Setup worksheet. To cancel your edits, select Abort Pin Setups Edit.

+ Any errors from updating the worksheet are written to the Message 
Window on page 8-16. 
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Pins Edit Popup
Overview

Both the Pin List Edit Worksheet on page 8-71 called from the Pin List Worksheet on page 
8-70 and the Pin Setup Edit Worksheet on page 8-74 called from the Pin Setups Worksheet on 
page 8-72 allow you to use the Pins Edit dialog box for editing the Name column in the Pin 
List and Pin Setup worksheets. Also, you can use this popup to edit the name of the 
multiplexed pins specified in the Mux: Alt Pins column on the Pin Setup Edit worksheet.

Using the Pins Edit Popup

+ If you have opened the Pins Edit popup from the Pin List Edit 
worksheet, the popup includes a box labeled $tset. To set this cell to 
$tset, check the box; if the box is checked, you cannot add any pins, 
and the other controls on the popup are disabled.

On the Pins Edit dialog box, the List window displays the current contents of the cell. You 
can add or delete pins or pin groups:

To add a pin or pin group to the list:

1. Enter a name in the Pin or pin group name field or use the scroll list that includes all pin 
and pin group names from the pattern file, and any pins from the pinmap if you have read 
in a pinmap; refer to Reading the Pinmap on page 8-76.

2. Click Add. The items are added   Repeat Steps 1 and 2 for as many items as required.

To delete a pin or pin group:

1. In the List window, highlight the items to delete by clicking on them.

2. Click Delete to add the item to the List window. Repeat Steps 1 and 2 for as many items as 
required.

3. Click OK to delete the items.

+ If the List window contains multiple items, they are enclosed in 
parentheses in the cell on the edit worksheet. The parentheses signify 
the items are an unnamed group.
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Reading the Pinmap

Overview

The pin list displayed in the Pin List worksheet is based on the vector statement in the pin 
list from the pattern file. By default, the Pin List worksheet contains all pins and groups in 
this pattern file; however, the Pin List worksheet may be a subset of the pins and groups 
defined on the Pin Map sheet of the test program workbook. Consequently, you can import 
these additional pins and groups when editing the Pin List or Pin Setup workbook by using 
the Read Pinmap command.

Using Read Pinmap

On the File menu, select Read Pinmap. The Open Pinmap dialog box opens. By default, this 
box displays the name of the workbook and pinmap sheet specified on the Options 
worksheet. You can specify a different workbook and pin map sheet in the Pin Map 
workbook and pinmap sheet fields. If the workbook contains only one pinmap, the pinmap 
sheet name can be blank.

To select a pinmap file, click the Browse button. An Open Pinmap dialog appears. After you 
have selected the pinmap file, click OK to load it.

Effects of Reading the Pinmap

The effects of reading the pinmap appear on the Pin List Edit and Pin Setup Edit worksheets. 
The drop-down lists for the Name columns for these two worksheets and the Pins Edit 
popups include all pins and pin groups from the pinmap, including those not used in the 
vector statement pin list. You can also directly enter the pin and group names into the 
appropriate columns of the Pins Edit popups. When you try to update the worksheet using the 
edit worksheet, PatternTool validates your edits, ensuring the entered pin or group names 
are valid. After you execute a Read Pinmap command, PatternTool uses all names from the 
pinmap, not just the default list; any name from the pinmap is valid.

Options Worksheet
Overview

The Options worksheet displays options that were selected when the pattern file was 
compiled. For more information about the compiler control statements, refer to Compiler 
Control Statements on page 6-23, Pattern Language Reference, Chapter 6. 



PatternTool 8

8-77Software Release 1.0
Part Number 560-968-00, Revision 1

Other Worksheets

8
Pa

tte
rn

To
ol

Row Header Column

The row headers identify the options. The row headers cannot be deleted or inserted.

Value Column

This column lists the current value for each option.

When editing this column:

• If a Value cell has a predefined set of keyword values, such as yes and no or normal and 
extended, you can directly edit the selected cell or select one of the keywords from the 
drop-down list.

• If a Value cell lists a user-supplied string, such as a version value or the min_period value, 
select the cell and directly edit the value.

• If you cut a value from a Value column, any cells requiring a value are set to the default 
state and other cells are cleared.
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File Statement Column

This column lists where the File Statement option was specified:

• yes—as a statement in the .atp source file.

• no—at compilation time by the Pattern Compiler GUI or command line.

To edit this column, you can directly edit the selected cell or select one of the keywords, yes 
and no, from the drop-down list.

Changing the File Statement value affects the reverse compilation of the file. If the new value 
is yes, reverse compilation will recreate the File Statement in the output .apt file; if no is the 
new value, the statement will not be recreated. For more information about reverse 
compilation, refer to Pattern Reverse Compiler on page 7-2, Pattern Compiler and Pattern 
Reverse Compiler, Chapter 7. 

Effects of Changing the Compiling Options

Several options affect compiling of the pattern file: for example, the Pin Map workbook. 
Changing these options will have no affect unless you use the reverse compiler to create an 
.atp file from the pattern file and then compile the .atp file again.

• Changing the opcode_mode from normal to extended or vice versa immediately affects 
the Vectors worksheet. In the normal mode, opcodes and labels can appear only on every 
other vector; in the extended mode, they can appear on every vector. If the file was 
compiled in the extended mode, and you change the mode to normal, any invalid opcodes 
or labels appearing on the wrong vectors are highlighted, indicating an error.

• The normal and extended modes require different min_period values; thus, if you change 
the mode, the minimum period may require changing.

• When adding comments to a pattern file that previously did not have comments, change the 
save_comments value to yes; otherwise, they will not be saved; refer to save_comments 
Option on page 8-60.
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Imports Worksheet
Overview

This worksheet lists the tset (time set) names and label names imported into the pattern file 
by the import statement in the pattern file. All tset names and external labels referenced in a 
pattern file must be imported. For more information, refer to Imported tset or Label 
Statement on page 6-25, Pattern Language Reference, Chapter 6. 

Type Column

This column declares the type of the imported item:

• tset—an imported tset

• subr—a label for a subroutine

• svm_subr—a label for an SVM-only subroutine

• label—an external label

Symbol Column

This column lists a user-supplied name for the tset or label.

Editing the Imports Worksheet

You can directly edit existing Type and Symbol definitions. Existing Type definitions can be 
edited directly or select an item from the drop-down list.

To add definitions of imported items:

1. Insert a new row; refer to Inserting and Deleting Rows on page 8-26.

2. In the blank row, define the type of item by selecting it from the drop-down list in the Type 
field.

3. In the Symbol field, enter a valid name.

To delete a pin setup, delete the row with the item; refer to Inserting and Deleting Rows on 
page 8-26

When saving an edited pattern file, the file is checked for duplicate or invalid tset names or 
labels; refer to File Checking on page 8-14.
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Instruments Worksheet
Overview

This worksheet lists any instruments statement in the pattern file. This statement defines 
instruments that have extended microcode programmed in the file. Currently, the 
instruments statement only defines which data generator is used by the Memory Test 
Module (MTM).

This worksheet cannot be edited.

Name Column

This column always indicates mtm.

Type Column

This column specifies which data generator is to used—2-bit or 16-bit—dgen_2bit or 
dgen_16bit.

Pin Count Column

This column is always 0; it has no significance and is ignored by PatternTool.
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Overview
History RAM (HRAM) is a pattern memory that captures data about pattern cycles while a 
pattern is executing. After a pattern has been executed, the captured data is available for 
viewing. The HRAM helps in pattern debugging of the most recent pattern burst.

To display the HRAM:

1. Connect to the job.

You must connect to the IG-XL job that generated the HRAM. You can connect to the job 
by using DataTool to run the job and to then invoke PatternTool; refer to Connecting to 
a Job for Debugging on page 8-82.

2. Select a method for displaying the HRAM.

After you have connected to the program, select one of the following methods for 
displaying the HRAM.

• Overlay the HRAM data on a pattern file.

a. Open a pattern file used in the test program.

b. From the View menu, select Programmed, Actual, or Fail Status. The HRAM data will 
be overlaid on the file data; refer to Overlaying the HRAM Data on the File Data on 
page 8-84.

• Open an HRAM window. 

From the View menu, select HRAM. An HRAM window opens, displaying HRAM data 
in addition to the pin data; refer to Opening the HRAM Window on page 8-85 and HRAM 
Window Columns on page 8-85.

3. Viewing the HRAM.

Viewing the HRAM is similiar whether the HRAM data is overlaid or the HRAM window 
is used; refer to Viewing the HRAM on page 8-88.
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Connecting to a Job for Debugging
Before you can view the HRAM data, PatternTool must be connected to the most recently 
executed job. You can invoke PatternTool from DataTool by using the DataTool toolbar 
or from the IG-XL menu. This method ensures PatternTool is connected to the job when the 
PatternTool window opens.

You can invoke PatternTool independently by opening DataTool to run a program, and 
then connecting to the program by selecting the Connect command on the Debug menu.

To disconnect from a job, select the Disconnect command on the Debug menu.

Displaying the Pattern and Tester Status

When PatternTool is connected to a job, the current tester status is displayed in the four 
panes at the right end of the status bar. The status is updated at intervals, or you can update 
the status by selecting the Debug command on the Debug menu.

PATGEN Pane

PATGEN vec: N Pattern generator is running a pattern. Vector number N was the 
vector being executed when the status was last read.

PATGEN: Keepalive Pattern generator is running the keepalive vectors.

PATGEN: Stopped Pattern generator is stopped.

HRAM Pane

HRAM: Not Started No pattern has been run yet.

HRAM: Keepalive Keep-alive vectors are being captured.

HRAM: Patgen running Pattern generator is running a pattern.

HRAM: N cycles Pattern generator has completed running a pattern. N is the 
number of cycles captured in HRAM.

The Fails Pane

Fails: N N is the number of failures in the last pattern run.
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Debug Connection status:

DEBUGGING PatternTool is connected to the job for debugging patterns.

CONNECTING PatternTool is attempting to connect to the job for debugging. 
No job has been started or the job has not started the DLL 
necessary for communicating with PatternTool. If you get this 
message, you should load a job in DataTool and, if necessary, 
click on the PatternTool button on the DataTool toolbar to 
complete the connection.

UNCONNECTED PatternTool is no longer connected or is no longer attempting 
to connect for debug because another instance of PatternTool 
may already be connected to the job.

(blank) PatternTool has not attempted to connect to the job for debug, 
or you may have disconnected from the job by selecting the 
Disconnect command on the Debug menu.



PatternTool8

8-84 Software Release 1.0
Part Number 560-968-00, Revision 1

Displaying the History RAM

Overlaying the HRAM Data on the File Data
Overview

One method for displaying the HRAM data is to overlay it on top of a pattern file, so you can 
see how the file data corresponds to the captured failures in the HRAM data. By viewing the 
relationship between the vectors and the failures, you can edit the vectors causing the 
failures.

Many of the features for viewing the HRAM display overlaid on the pattern file are the same 
as displaying the file data in the HRAM window, such as, the colors used, the display of 
repeated vectors, and the way to view other sites; refer to Viewing the HRAM on page 8-88.

Method

1. Open a pattern file for the job that has been executed; Opening an Existing Pattern File on 
page 8-8.

2. With the pattern file as the active window, select from the View menu one of the following 
types of HRAM data to display:

Programmed—Programmed (expect) data, captured from the tester.

Actual—Data actually read from the device.

Fail Status—Pass/fail status for each pin.

You can overlay only one type of data at a time. To display more than one type of data 
simultaneously, use the HRAM window; refer to Opening the HRAM Window on page 8-85.

The cell in the upper left corner of the window displays your current selection: 

Prog
Actual
Fails

3. To return to the display of the pattern file data without the HRAM data, select View from 
the File Data menu in PatternTool. This command also lets you edit the file again. The 
HRAM display is read-only.
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Viewing HRAM Data in the HRAM Window
Overview

One option for displaying the HRAM data is to open an HRAM window and view the 
captured vectors. The displayed vectors are in the order they were executed. The HRAM 
window is read-only. You cannot edit the displayed data.

Many of the features for viewing the file data in the HRAM window are the same as viewing 
the HRAM display overlaid on the pattern file, such as, the colors used, the display of 
repeated vectors, and the way to view other sites; refer to Viewing the HRAM on page 8-88.

Opening the HRAM Window

1. On the View menu, select HRAM. The History RAM window opens.

2. To specify the HRAM data to display, select one or more of the following options from the 
View menu:

Programmed—Programmed (expect) data, captured from the tester.

Actual—Data read from the device.

Fail Status—Pass or fail status for each pin.

In the open HRAM window, the default data displayed is Programmed. The letter .P, .A, or .F 
is appended to the row number, signify the data displayed in that row.

HRAM Window Columns

Overview

You can use the standard PatternTool commands on the Column menu to change the 
appearance of the columns in the HRAM Display; refer to Changing the Column Appearance 
on page 8-10:

• Hide and expose columns.

• Change the radix of a column with a radix header (:H, :S, :B, :D, or :O). 

• Expand and collapse the pin data columns for pin groups.

• Create groups from individual pins.
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Row Numbers Column

 The row numbers list the index number of the History RAM. These numbers end with a 
letter indicating the kind of pin data displayed in this row: .P = Programmed, .A = Actual, 
.F = Fail Status.

For the SCIO or mux mode, the row headers also contain a .1 or .2.

vector Column

This column lists the pattern file name without the .pat extension and the vector offset within 
the file.

cycle Column

This column lists the cycle count for this vector.

label Column

This column lists any label for this vector in the pattern file.

patgen microcode Column

This column lists any microcode for this vector.

repeat / loop Column

This column lists the counter selected to be captured by the HRAM. The HRAM captures 
only one counter: Repeat, LoopA, LoopB, or LoopC. The name of the counter appears in the 
column header. In this column the repeated rows display a count-down to 0.

mem Column

This column lists the source of the tester memory vector: S = SVM, L = LVM, K =  
Keepalive.
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Flags Columns: fmtf, fail, ext, cpua, flag

This column lists whether the pattern generator has enabled various flags on this vector. 
Enabled flags are labeled Y, disabled flags are labeled N. If flags are enabled, the pattern can 
use the if opcode to branch; refer to Conditional Statements on page 6-91, Pattern Language 
Reference, Chapter 6. 

• fmtf—Format fail—The vector N cycles earlier failed. The fmtf flag is set only once per 
failing vector; refer to note below.

• fail—Vector N or more cycles earlier failed. Once the fail flag is set, it remains set until it 
is cleared by the pattern or test program; refer to note below.

+ Y for fail or fmtf on this vector does not mean this vector failed. When 
a vector fails, a fail flag is set N vectors later, where N is the pipeline 
depth. PatternTool compensates for the pipeline delay when 
determining if the current vector failed, signified by the red or green 
color of the vector.

• ext—External flag set by the auxiliary pattern generator.

• cpua—Flag set from the pattern or the test program.

• flag—Whether the pattern has enabled a user flag for a subsequent if statement. For 
information about the enable opcode, Conditional Statements on page 6-91, Pattern 
Language Reference, Chapter 6.

tset Column

This column lists the timing set name or number for this vector.

Pin Data Column

This row displays the pin data for this vector, as determined by the display mode for this row: 
programmed, actual, or fail status.

If a pin data column is for a pin group, and a failure occurred on one or more pins, the entire 
group is red, meaning failure. To view the pass/fail results for individual pins, expand the 
column; refer to Expanding and Collapsing Columns on page 8-49.
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Viewing the HRAM
Overview

PatternTool has common HRAM viewing features whether the HRAM data is overlaid on 
the pattern file or is viewed in a separate HRAM window. For information about the 
differences in how each method displays the HRAM data refer to:

• Overlaying the HRAM Data on the File Data on page 8-84 

• Viewing HRAM Data in the HRAM Window on page 8-85

Display Colors

The HRAM data is displayed in green except for pin data containing a failure, which is red. 
For a pin group, only the failed pins are red; the rest are green.

When HRAM data is overlaid on a pattern file, some of the pin data may be black, which 
means the data was read from the pattern file, not from the HRAM. The data may have been 
read from the pattern file because the vector:

• was not executed, due to branching within the pattern.

• was not captured in the HRAM because of the HRAM setup instructions. 

If data, such as labels and opcode, was read from the drivers, it is green; however, if it was 
read from the pattern file, it is black. In the HRAM window, all data is from HRAM; thus, it 
is always either green or red.
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Display Symbols

If you include Fail Status as a viewing type, the row headers appended with an .F show the 
pass/fail result for each pin, instead of the expect or actual data:

• Column radix is Symbolic: green plus sign (+) represents a passing pin; red F represents a 
failing pin.

• Blank cell: No failures in the cell.

• Column radix is not Symbolic, but numeric, prefixed with .f, which identifies the passing 
and failing pins: 1 for a failing pin and 0 for a passing pin. For example, assume the 
following hexadecimal value:

.fA06

In the Symbolic mode, this example expands into the following passes and fails:

F+F++++++FF+

The zeroes are green, meaning that none of the pins in these positions failed; all other digits 
are red, meaning that at least one of the pins represented by this digit failed. If all pins in this 
group passed, the value would be:

.f000

In all viewing modes, if a pin group uses the Decimal radix, the entire number is displayed in 
red if any of the pins has a failure because decimal digits do not map to discrete groups of 
pins.

Repeated Vectors

A single vector in a pattern file may generate multiple vectors if the vector has a repeat 
opcode or is part of a loop. How the repeated vectors are displayed depends on the display 
window used:

• When HRAM data is overlaid on the pattern file, the display shows the HRAM only for the 
first cycle generated by the vector.

• In the HRAM window, the display shows each cycle generated by the repeated vector. The 
repeat or loop column lists a number for each repeated vector, without the numbers 
counting down to 0.

Viewing Sites
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